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The erich plug-in system

1 Introduction

eric 4.1 introduced a plug-in system, which allows easy extension of the IDE. Every user
can customize the application by installing plug-ins available via the Internet. This
document describes this plug-in system from a user perspective and from a plug-in
developers perspective as well.

2 Description of the plug-in system

The eric5 plug-in system is the extensible part of the eric5 IDE. There are two kinds of
plug-ins. The first kind of plug-ins are automatically activated at startup, the other kind are
activated on demand. The activation of the on-demand plug-ins is controlled by
configuration options. Internally, all plug-ins are managed by the PluginManager object.
Deactivated autoactivate plug-ins are remembered and will not be activated automatically
on the next start of eric5.

Ericb comes with quite a number of core plug-ins. These are part of the eric5 installation.
In addition to this, there are additional plug-ins available via the internet. Those plug-ins
may be installed and uninstalled using the provided menu or toolbar entries. Installable
plug-ins live in one of two areas. One is the global plug-in area, the other is the user plug-
in area. The later one overrides the global area.

3 The plug-in system from a user perspective

The eric5 plug-in system provides the user with a Plug-ins menu in the main menu bar and
a corresponding toolbar. Through both of them the user is presented with actions to show
information about loaded plug-ins and to install or uninstall plug-ins.

3.1 The Plug-ins menu and toolbar

The plug-ins menu is located under the “Plugins” label in the main menu bar of the eric5
main window. It contains all available user actions and is accompanied by a toolbar
containing the same actions. They are shown in the following figures.

File Edit Wiew Start Debug Unittest Project Extras Settings Window ankmarksﬂelp

Figure 1: eric5 main menu

.. PluginInfos. ..
.. Install Plugins. ..

& Uninstall Flugin...
ol Plugin Repositony..
Configure. ..

Figure 2: The Plug-ins menu

Page 4 of 44



The erich plug-in system

- E aEm A
Figure 3: The Plug-ins toolbar

The “Plugin Infos...” action is used to show a dialog, that lists all the loaded plug-ins and
there status. The entry labeled “Install Plugins...” opens a wizard like dialog to install new
plug-ins from plug-in archives. The entry, “Uninstall Plugin...”, presents a dialog to uninstall
a plug-in. If a plug-in to be uninstalled is loaded, it is unloaded first. The entry called
“Plugin Repository...” shows a dialog, that displays the official plug-ins available in the
eric5 plug-in repository. The “Configure...” entry opens the eric5 configuration dialog
displaying the Plugin Manager configuration page.

3.2 The Plug-in Infos dialog

The “Plugin Infos” dialog shows information about all loaded plug-ins. Plug-ins, which had
a problem when loaded or activated are highlighted. More details are presented, by double
clicking an entry or selecting the “Show details” context menu entry. An example of the
dialog is show in the following figure.
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31 Loaded Plugins

Double-Click an entry to show detailed info. Plugins with an error are shown in red.

Maodule

MName

Version

Autoactivate |Mtive

|Description

PluginAbout

About Plugin

4.2.0

Yes

Yes

Show the About dialogs.

FluginAssistantEric
FluginCharTakles
FluginCxFreeze
FluginEricapi
FluginEricdoc
FluginFrojectDjango
FluginProjectTurboGears
PluginProjectxPython
PluginPyLint
PluginRefactoringBRM
PluginRefactoringRope
PluginSyntaxChecker
PluginTabnanny
PluginvcsCWs
PluginVcsPySwvn
PluginvcsSubversion
PluginvWmListspace
FluginVmMdifrea
FluginvmTabview
FluginvmWaorkspace
FluginWizardPyRegExp
FluginWizard@ColorDialog
FluginWizardQFileDialog
FluginWizard@FontDialog
FluginWizardQinputDialog

FluginWizard@MessageBox

PluginWizardQRegExp

Assistant Eric Flugin
CharTahles Plugin
CxFreeze Plugin

Ericapi Flugin

Ericdoc Plugin

Django Project Plugin
TurboGears Project Plugin
wixPython Project Plugin
PyLint Plugin

Refactoring BRM Plugin
Refactoring Rope Plugin
Syntax Checker Plugin
Tabnanny Plugin

CWS Plugin

PySvn Plugin

Subversion Plugin
Listspace Plugin
Workspace Plugin
Tabview Plugin
Workspace Plugin

Python re Wizard Plugin
QColorDialog Wizard Plugin
QFileDialog Wizard Plugin
QF ontDialog Wizard Plugin
QlnputDialog Wizard Plugin

QMessageBox Wizard Plugin

QRegExp Wizard Plugin

1.0.0-snapshot-20080716
413
413
420
420
1.01
1.01
1.01
412
412
1.1.0-snapshot-20080712
420
420
415
420
420
420
1.00
420
420
420
420
420
420
420
420
420

Yes
Yes
Yes
Yes
Yes
Yes
Yes
fes
fes
fes
fes
fes
fes
Mo
Mo
Mo
Mo
MNa
MNa
MNa

Yes
Yes
Yes
Yes
Yes
Yes
Yes
fes
fes
Mo
fes
fes
fes
Mo

Mo
Mo
Mo

Mo

Alternative autocompletion and cal
Dialog showing various character
Show the CxFreeze dialogs.

Show the Ericapi dialogs.

Show the Ericdoc dialogs.

Project support for Django projects
Project supportfor TurboGears prc
Project support for wxPython projet
Show the PyLint dialogs.
Refactoring with Bicycle Repair Ma
Refactoring using the Rope library.
Show the Syntax Checker dialog.
Show the Tabnanny dialog.
Implements the CVS version contr
Implements the PySvn version con
Implements the Subversion versio
Implements the Listspace view mz
Implements the MDIArea view mar
Implements the Tabview view man
Implements the Workspace view
Show the Python re wizard.

Show the QColorDialog wizard.
Show the QFileDialog wizard.
Show the QFontDialog wizard.
Show the QinputDialog wizard.
Show the QMessageBox wizard.
Show the QRegExp wizard.

£l

Figure 4: Plug-ins Info dialog

The columns show information as follows.

e Module

oo

This shows the Python module name of the plug-in. It is usually the name of the
plug-in file without the file extension. The module name must be unique.

e Name

This is the name of the plug-in as given by the plug-in author.

e \Version

This shows the version of the plug-in.

e Autoactivate

This indicates, if the plug-in should be activated at startup of the eric5 IDE. The
actual activation of a plug-in is controlled by the state it had at the last shutdown of

erich.
e Active

This gives an indication, if the plug-in is active.

e Description

This column show a descriptive text as given by the plug-in author.
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This dialog has a context menu, which has entries to show more details about a selected
plug-in and to activate or deactivate an autoactivate plug-in. It is shown below.

Show details Show details
Activate
Deactivate
Figure 5: Plug-ins Info dialog context menu

Deactivated plug-ins are remembered and will not be activated automatically at the next
startup of eric5. In order to reactivate them, the “Activate” entry of the context menu must
be selected.

Selecting the “Show details” entry opens another dialog with more information about the
selected plug-in. An example is shown in the following figure.

E] Plugin Details
Module name: PluginRefactoringBRM

Module filename: [fhamefdetlew.eric4feric4p|uginsfPIuginRefactDringBRM.pj,r

(%] Autoactivate [ | Active

Plugin name: [Refactnring BRM Plugin

\ersion: [4.1.0

Author: [Detlev Offenbach =detlev@die-offenbachs.de=

Description: This plugin implements refactoring functionality using the Bicycle
Repair Man package.

Figure 6: Plug-in Details dialog

The entries of the dialog are as follows.

e Module name:
This shows the Python module name of the plug-in. It is usually the name of the
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plug-in file without the file extension. The module name must be unique.

e Module filename:
This shows the complete path to the installed plug-in Python file.

e Autoactivate
This indicates, if the plug-in should be activated at startup of the eric5 IDE. The
actual activation of a plug-in is controlled by the state it had at the last shutdown of
erich.

e Active
This gives an indication, if the plug-in is active.

e Plugin name:
This is the name of the plug-in as given by the plug-in author.

e \Version:
This shows the version number of the installed plug-in. This number should be
passed to the plug-in author when reporting a problem.

e Author:
This field gives the author information as provided by the plug-in author. It should
contain the authors name and email.

e Description:
This shows some explanatory text as provided by the plug-in author. Usually this is
more detailed than the short description displayed in the plug-in infos dialog.

e Error:
In case a plug-in hit an error condition upon loading or activation, an error text is
stored by the plug-in and show in this field. It should give a clear indication about
the problem.

3.3 Installing Plug-ins

New plug-ins are installed from within eric5 using the Plug-in Installation dialog. It is show,
when the “Install Plugin...” menu entry is selected. Please note, that this is also available
as a standalone tool using the eric5-plugininstall. py script or via the eric5 tray
menu. The user is guided through the installation process by a wizard like dialog. On the
first page, the plug-in archives are selected. eric5 plug-ins are distributed as ZIP-archives,
which contain all installable files. The “Add ..."-button opens a standard file selection
dialog. Selected archives may be removed from the list with the “Remove”-Button.
Pressing the “Next >” button continues to the second screen.
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[] Plugin Installation

Enter the plugin archives to install

fhome/detlev/.ericd/Downloads/PluginCharTables.zip
fhome/detlev/.ericd/Downloads/PluginCxFreeze.zip
fhomefdetlevf.ericd/Downloads/PluginPyLint.zip

fhome/detlev/. eric4/Downloads/PluginRefactoringBRM.zip
fhome/detlev/.eric4/Downloads/PluginvcsCVs.zip

[ = Back H Next > H Finish H Cancel ]

Figure 7: Plug-ins Installation dialog, step 1

The second display of the dialog is used to select the directory, the plug-in should be
installed into. If the user has write access to the global eric5 plug-ins directory, both the
global and the user plug-ins directory are presented. Otherwise just the user plug-ins
directory is given as a choice. With the “< Back” button, the user may go back one screen.
Pressing “Next >” moves to the final display.
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H] Plugin Installation

Select the destination plugin directory

[User plugins directory

[ < Back H Next > H Finish H cancel ]

Figure 8: Plug-ins Installation dialog, step 2

The final display of the plug-in installation dialog shows a summary of the installation data
entered previously. Again, the “< Back” button lets the user go back one screen. The
“Finish” button is used to acknowledge the data and starts the installation process.
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[] Plugin Installation

Installation Summary

Flugin ZIP-Archives:

fhome/detlev/. ericd/Downloads/PluginCharTables.zip
fhome/detlev/.eric4/Downloads/FluginCxFreeze.zip
fhome/fdetlev/.ericd/Downloads/PluginPyLint. zip
Mhome/detlev/. ericd/Downloads/PluginRefactoringBRM.zip
fhome/detlev/.ericd/Downloads/PluginvcsCVS.zip

Destination:
User plugins directory (fhome/detlev. ericd/ericdplugins)

0%

Figure 9: Plug-ins Installation dialog, step 3

The installation progress is show on the very same page. During installation the plug-in
archives is checked for various conditions. If the installer recognizes a problem, a
message is shown and the installation for this plug-in archive is aborted. If there is a
problem in the last step, which is the extraction of the archive, the installation process is
rolled back. The installation progress of each plug-in archive is shown by the progress bar.
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E] Plugin Installation

Installation Summary

Installing /home/detlev/. ericd/Downloads/PluginCharTables.zip ...
InﬂsL’:aIIing /home/detlev/.ericd/Downloads/PluginCxFreeze.zip ...
Inﬂs}:alling fhome/detlev/.ericd/Downloads/PluginPyLint.zip ...
Inﬂsfalling fhome/detlevf.ericd/Downloads/PluginRefactoringBRM.zip ...
Inﬂsfalling fhome/detlev/.ericd/Downloads/PluginvesCVs.zip ...

ok

INEERRENNRNNENETCENNNNNNNNENEN]

[ < Back H Next = H Finish H cancel ]

Figure 10: Plug-ins Installation dialog, step 4

Once the installation succeeds, a success message is shown.

B Plugins Installation

@ The plugins were installed successfully

Figure 11: Plug-ins Installation dialog, step 5

If plug-ins are installed from within eric5 and are of type “autoactivate”, they are loaded
and activated immediately. Otherwise they are loaded in order to add new on-demand
functionality.

3.4 Uninstalling Plug-ins

Plug-ins may be uninstalled from within eric5 using the “Uninstall Plugin...” menu, via the
eric5-pluginuninstall. py script or via the eric5 tray menu. This displays the “Plugin
Uninstallation” dialog, which contains two selection list. The top list is used to select the
plug-in directory. If the user has write access in the global plug-ins directory, the global
and user plug-ins directory are presented. If not, only the user plug-ins directory may be
selected. The second list shows the plug-ins installed in the selected plug-ins directory.
Pressing the “OK” button starts the uninstallation process.
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HE] Plugin Uninstallation
Plugin directory:

[User plugins directory

Plugin;

[F’IuginRefactnringBRM

(8] 4 H Cancel l

Figure 12: Plug-in Uninstallation dialog, step 1

H1Plugin Uninstallation <2>

@ The plugin PluginRefactoringBRM was uninstalled successfully
from /home/detlevf.ericdfericdplugins.

Figure 13: Plug-in Uninstallation dialog, step 2

The uninstallation process deactivates and unloads the plug-in and finally removes all files

belonging to the selected plug-in from disk. This process ends with a message confirming
successful uninstallation of the plug-in.

3.5 The Plug-ins repository

Eric5 has a repository, that contains all official plug-ins. The plug-in repository dialog may
be used to show this list and download selected plug-ins.
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&1 | Plugin Repository

Name / |Versi0n Short Description
Stable

; (3 4.1.0-snapshot-20071224 Interface to the CWS version control system.

b PyLint 3 4.1.0-snapshot-20071209 Interface to the pylint checker program.
Unstable

- CharTables 3 4.1.0-snapshot-20071209 Dialog showing various character tables,

. - CHFreeze (7 4.1.0-snapshot-20071209 Interface to the cxireeze packaging program.
-- RefactoringBRM 4.1.0-snapshot-20080102 Refactoring with Bicycle Repair Man.

Description: | This plugin implements the CxFreeze dialogs. CxFreeze is used to generate a distribution package.

Displays the description of the selected plugin

Author: [Detlev Offenbach =detlev@die-offenbachs. de=

URL: [ http:/fdie-offenbachs.homelinux orgferic/plugins/PluginCxFreeze.zip

0%

l Update ] [Download] [ Cancel ] [Close&lnstalll l Close

Figure 14: Plug-in Repository dialog

The upper part of the dialog shows a list of available plug-ins. This info is read from a file
stored in the eric5 user space. Using the Update button, this file can be updated from the
Internet. The plug-ins are grouped by their development status. An icon next to the version
entry indicates, whether this plug-in needs an update. More detailed data is shown in the
bottom part, when an entry is selected. The data shown is the URL of the plug-in, some
detailed description and the author of the plug-in. Pressing the Download button gets the
selected plug-ins from the presented URL and stores them in the users plug-in download
area, which may be configured on the Plug-ins configuration page of the configuration
dialog. The Cancel button will interrupt the current download. The download progress is
shown by the progress bar. Pressing the Close & Install button will close this dialog and
open the plug-in installation dialog (s. chapter 3.3).

4 Erich for plug-in developers

This chapter contains a description of functions, that support plug-in development with
eric5. Eric5 plug-in projects must have the project type “Eric5 Plugin”. The project's main
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script must be the plug-in main module. These project entries activate the built-in plug-in
development support. These are functions for the creation of plug-in archives and special
debugging support. An example of the project properties is shown in the following figure.

HElProject Properties

Project Name: PluginBRM|

Progr. Language: [F’ythcm

[ | Mixed programming languages

Project Type: | Ericd Plugin

\ersion Mo.:

Main Script:

Author: [Detlev Offenbachs

Email: [detlev@die-aﬁenbachs.de

Description:

The project is version controlled by Subversion (pyswvn). [Shcw Repository Infu]

| oK H Cancel

Figure 15: Plug-in specific project properties

To support the creation of plug-in package archives, the Packagers submenu of the
Project menu contains entries to ease the creation of a package list and to create the plug-
in archive.

« | Create Package List
«p Create PluginArchive
- Create Plugin Archive (Snapshot)

Figure 16: Packagers submenu
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The “Create package list” entry creates a file called PKGLIST, which is used by the archive
creator to get the list of files to be included in the plug-in archive. After the PKGLIST file

has been created, it is automatically loaded into a new editor. The plug-in author should
modify this list and shorten it to just include the files required by the plug-in at runtime. The
following listing gives an example.

PluginRefactoringBRM.py
RefactoringBRM/ConfigurationPage/RefactoringBRMPage.py
RefactoringBRM/ConfigurationPage/Ui_RefactoringBRMPage.py
RefactoringBRM/ConfigurationPage/ init_  .py
RefactoringBRM/ConfigurationPage/preferences-refactoring.png
RefactoringBRM/MatchesDialog.py
RefactoringBRM/Refactoring.py

RefactoringBRM/Ui MatchesDialog.py
RefactoringBRM/__init .py
RefactoringBRM/brm/__init .py
RefactoringBRM/brm/bike/__init .py
RefactoringBRM/brm/bike/bikefacade.py
RefactoringBRM/brm/bike/globals.py
RefactoringBRM/brm/bike/log.py
RefactoringBRM/brm/bike/logging.py
RefactoringBRM/brm/bike/parsing/ __init .py
RefactoringBRM/brm/bike/parsing/constants.py
RefactoringBRM/brm/bike/parsing/fastparser.py
RefactoringBRM/brm/bike/parsing/fastparserast.py
RefactoringBRM/brm/bike/parsing/load.py
RefactoringBRM/brm/bike/parsing/newstuff.py
RefactoringBRM/brm/bike/parsing/parserutils.py
RefactoringBRM/brm/bike/parsing/pathutils.py
RefactoringBRM/brm/bike/parsing/utils.py
RefactoringBRM/brm/bike/parsing/visitor.py
RefactoringBRM/brm/bike/query/__init__ .py
RefactoringBRM/brm/bike/query/common.py
RefactoringBRM/brm/bike/query/findDefinition.py
RefactoringBRM/brm/bike/query/findReferences.py
RefactoringBRM/brm/bike/query/getAllRelatedClasses.py
RefactoringBRM/brm/bike/query/getReferencesToModule. py
RefactoringBRM/brm/bike/query/getTypeOf.py
RefactoringBRM/brm/bike/query/relationships.py
RefactoringBRM/brm/bike/refactor/__init_ .py
RefactoringBRM/brm/bike/refactor/extractMethod.py
RefactoringBRM/brm/bike/refactor/extractVariable.py
RefactoringBRM/brm/bike/refactor/inlineVariable.py
RefactoringBRM/brm/bike/refactor/moveToModule.py
RefactoringBRM/brm/bike/refactor/rename.py
RefactoringBRM/brm/bike/refactor/utils.py
RefactoringBRM/brm/bike/transformer/WordRewriter.py
RefactoringBRM/brm/bike/transformer/ init__ .py
RefactoringBRM/brm/bike/transformer/save.py
RefactoringBRM/brm/bike/transformer/undo.py
RefactoringBRM/il8n/brm cs CZ.qgm
RefactoringBRM/il8n/brm de.gm
RefactoringBRM/il8n/brm fr.qgm
RefactoringBRM/il8n/brm ru.gm

Listing 1: Example of a PKGLIST file

Page 16 of 44



The erich plug-in system

The PKGLIST file must be stored in the top level directory of the project alongside the
project file.

The archive creator invoked via the “Create Plugin Archive” menu entry reads this
package list file and creates a plug-in archive. This archive has the same name as the
plug-in module and is stored at the same place. The menu entry “ Create Plugin
Archive (Snapshot)”is used to create a snapshot release of the plug-in. This
command modifies the version entry of the plug-in module (see below) by appending a
snapshot indicator consisting of “-snapshot-" followed by the date like “20071206".

In order to debug a plug-in under development, eric5 has the command line switch
“--plugin=<plugin module filename>". That switch is used internally, if the project
is of type “Eric5 Plugin”.

5 Anatomy of a plug-in

This chapter describes the anatomy of a plug-in in order to be compatible with eric5.

5.1 Plug-in structure

An eric5 plug-in consists of the plug-in module file and optionally of one plug-in package
directory. The plug-in module file must have a filename, that starts with P1ugin and ends
with . py, e.g. PluginRefactoringBRM. py. The plug-in package directory may have an
arbitrary name, but must be unique upon installation. Therefore it is recommended to give
it the name of the module without the P1ugin prefix. This package directory name must

be assigned to the packageName module attribute (see the chapter describing the plug-in
module header).

5.2 Plug-in header

The plug-in module must contain a plug-in header, which defines various module
attributes. An example is given in the listing below.

# Start-Of-Header

name = "Assistant Eric Plugin"

author = "Detlev Offenbach <detlev@die-offenbachs.de>"

autoactivate = True

deactivateable = True

version = "1.2.3"

className = "AssistantEricPlugin"

packageName = "AssistantEric"

shortDescription = "Alternative autocompletion and calltips provider."

longDescription = """This plugin implements an alternative autocompletion"""
" and calltips provider."""

needsRestart = True

pyqtApi = 2

# End-Of-Header

error = ""

Listing 2: Plug-in header

The various attributes to be defined in the header are as follows.
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name

This attribute should contain a short descriptive name of the plug-in.

Type: string

author

This attribute should be given the name and the email address of the plug-in author.
Type: string

autoactivate

This attribute determines, whether the plug-in may be activated automatically upon
startup of eric5. If this attribute is False, the plug-in is activated depending on some

configuration settings.
Type: bool

deactivateable

This attribute determines, whether the plug-in may be deactivated by the user.
Type: bool

version

This attribute should contain the version number.

Type: string

className

This attribute must contain the name of the class implementing the plug-in. This
class must be contained in the plug-in module file.

Type: string

packageName

This names the package directory, that contains the rest of the plug-in files. If the
plug-in is of the simple type (i.e. all logic is contained in the plug-in module), the
packageName attribute must be assigned the value “None” (the string None).
Type: string

shortDescription

This attribute should contain a short description of the plug-in and is used in the
plug-in info dialog.

Type: string

longDescription

This attribute should contain a more verbose description of the plug-in. It is shown
in the plug-in details dialog.

Type: string

needsRestart

This attribute should make a statement, if eric5 needs to be restarted after plug-in
installation or update.
Type: boolean

pyqtApi

This attribute should indicate the PyQt QString and QVariant API version the plug-in
is coded for. Eric5 plug-ins must support at least version 2.

Type: integer

error

This attribute should hold an error message, if there was a problem, or an empty
string, if everything works fine.
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Type: string
e The'# Start-0Of-Header'and'# End-Of-Header' comments mark the start
and the end of the plug-in header.

If the autoactivate attribute is False, the header must contain two additional attributes.

pluginType = "viewmanager"
pluginTypename = "tabview"

Listing 3: Additional header for on-demand plug-ins

e pluginType
This attribute must contain the plug-in type. Currently eric5 recognizes the values
“viewmanager” and “version_control”.
Type: string

e pluginTypename
This attribute must containe the plug-in type name. This is used to differentiate the
plug-in within the group of plug-ins of the same plug-in type.
Type: string

Plug-in modules may define additional optional attributes. Optional attributes recognized
by eric5 are as follows.

e displayString
This attribute should contain the user visible string for this plug-in. It should be a
translated string, €.g. displayString = QApplication.translate('VcsCVSPlugin',
cvs'). This attribute may only be defined for on-demand plug-ins.
Type: string

If either the version or the className attribute is missing, the plug-in will not be loaded. If
the autoactivate attribute is missing or this attribute is False and the pluginType or the
pluginTypename attributes are missing, the plug-in will be loaded but not activated. If the
packageName attribute is missing, the plug-in installation will be refused by eric5.

5.3 Plug-in module functions

Plug-in modules may define the following module level functions recognized by the eric5
plug-in manager.

e moduleSetup()
e prepareUninstall()
e (getConfigData()
e previewPix()
e exeDisplayData()
e apiFiles(language)
These functions are described in more detail in the next few chapters.

5.3.1 moduleSetup()
This function may be defined for on-demand plug-ins (i.e. those with autoactivate being
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False). It may be used to perform some module level setup. E.g. the CVS plug-in uses this
function, to instantiate an administrative object to provide the login and logout menu
entries of the version control submenu.

def moduleSetup():

Public function to do some module level setup.

global __ cvsAdminObject
__cvsAdminObject = CVSAdminObject()

Listing 4: Example for the moduleSetup() function

5.3.2 prepareUninstall()

This function is called by the plug-in uninstaller just prior to uninstallation of the plug-in.
That is the right place for cleanup code, which removes entries in the settings object or
removes plug-in specific configuration files.

import Preferences

def prepareUninstall():

Module function to prepare for an uninstallation.

Preferences.Prefs.settings.remove("Refactoring")
Preferences.Prefs.settings.remove("RefactoringBRM")

Listing 5: Example for the prepareUninstall() function

5.3.3 getConfigData()

This function may be used to provide data needed by the configuration dialog to show an
entry in the list of configuration pages and the page itself. It is called for active autoactivate
plug-ins. It must return a dictionary with globally unique keys (e.g. created using the plug-
in name) and lists of five entries. These are as follows.

e display string
The string shown in the selection area of the configuration page. This should be a
localized string.
Type: Qstring

e pixmap name
The filename of the pixmap to be shown next to the display string.
Type: string

e page creation function
The plug-in module function to be called to create the configuration page. The page
must be subclasses from
Preferences.ConfigurationPages.ConfigurationPageBase and must
implement a method called 'save’ to save the settings. A parent entry will be created
in the selection list, if this value is None.
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Type: function object or None

e parent key

The dictionary key of the parent entry or None, if this defines a toplevel entry.
Type: string or None

e reference to configuration page

This will be used by the configuration dialog and must always be None.
Type: None

def getConfigData():

Module function returning data as required by the configuration dialog.

@return dictionary with key "refactoringBRMPage" containing the
relevant data

return {
"refactoringBRMPage" : \
[QApplication.translate("RefactoringBRMPlugin",
"Refactoring (BRM)"),
os.path.join("RefactoringBRM", "ConfigurationPage",
"preferences-refactoring.png"),
createConfigurationPage, None, None],

Listing 6: Example for the getConfigData() function

5.3.4 previewPix()

This function may be used to provide a preview pixmap of the plug-in. This is just called for
viewmanager plug-ins (i.e. pluginType == "viewmanager"). The returned object must be of
type QPixmap.

def previewPix():

Module function to return a preview pixmap.

@return preview pixmap (QPixmap)

fname = os.path.join(os.path.dirname(_ file ),
"ViewManagers", "Tabview", "preview.png")
return QPixmap (fname)

Listing 7: Example for the previewPix() function

5.3.5 exeDisplayData()

This function may be defined by modules, that depend on some external tools. It is used
by the External Programs info dialog to get the data to be shown. This function must return
a dictionary that contains the data for the determination of the data to be shown or a
dictionary containing the data to be shown.
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The required entries of the dictionary of type 1 are described below.

programentry

An indicator for this dictionary form. It must always be True.
Type: bool

header

The string to be diplayed as a header.

Type: Qstring

exe

The pathname of the executable.

Type: string

versionCommand

The version commandline parameter for the executable (e.g. - -version).
Type: string

versionStartsWith

The indicator for the output line containing the version information.

Type: string

versionPosition

The number of the element containing the version. Elements are separated by a
whitespace character.

Type: integer

version

The version string to be used as the default value.

Type: string

versionCleanup

A tuple of two integers giving string positions start and stop for the version string. It
is used to clean the version from unwanted characters. If no cleanup is required, it

must be None.
Type: tuple of two integers or None

Page 22 of 44



The erich plug-in system

def exeDisplayData():

Public method to support the display of some executable info.

@return dictionary containing the data to query the presence of
the executable

exe = 'pylint’

if sys.platform == "win32":
exe = os.path.join(sys.exec prefix, "Scripts", exe + '.bat')

data = {
"programEntry" : True,
"header" : QApplication.translate("PyLintPlugin",
"Checkers - Pylint"),
"exe" . exe,
"versionCommand" : '—--version',
"versionStartsWith" : 'pylint’',
"versionPosition" : -1,
"version" s ",
"versionCleanup" : (0, -1),

}

return data

Listing 8: Example for the exeDisplayData() function returning a dictionary of type 1

The required entries of the dictionary of type 2 are described below.

e programentry
An indicator for this dictionary form. It must always be False.
Type: bool

e header
The string to be diplayed as a header.
Type: string
e text
The entry text to be shown.
Type: string
e Vversion

The version text to be shown.
Type: string
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def exeDisplayData():

Public method to support the display of some executable info.

@return dictionary containing the data to be shown
try:
import pysvn
try:
text = os.path.dirname(pysvn. file )
except AttributeError:

text = "PySvn"

version = ".".join([str(v) for v in pysvn.version])
except ImportError:

text = "PySvn"

version = ""
data = {

"programEntry" : False,

"header" : QApplication.translate("VcsPySvnPlugin",

"Version Control - Subversion (pysvn)"),
"text" . text,
"version" : version,

}

return data

Listing 9: Example for the exeDisplayData() function returning a dictionary of type 2

5.3.6 apiFiles(language)

This function may be provided by plug-ins providing API files for the autocompletion and
calltips system of eric5. The function must accept the programming language as a string
and return the filenames of the provided API files for that language as a list of string.

def apiFiles(language):

Module function to return the API files made available by this plugin.

@return list of API filenames (list of string)

if language == "Python":
apisDir = \
os.path.join(os.path.dirname(__file ), "ProjectDjango", "APIs")
apis = glob.glob(os.path.join(apisDir, '*.api'))
else:
apis = []

return apis

Listing 10: Example for the apiFiles(language) function
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5.4 Plug-in object methods

The plug-in class as defined by the className attribute must implement three mandatory
methods.

e _ init_ (self, uil)
e activate(self)
e deactivate(self)

These functions are described in more detail in the next few chapters.

5.4.1 _ init__ (self, ui)

This method is the constructor of the plug-in object. It is passed a reference to the main
window object, which is of type UI.UserInterface. The constructor should be used to
perform all initialization steps, that are required before the activation of the plug-in object.
E.g. this would be the right place to load a translation file for the plug-in (s. Listing 14) and
to initialize default values for preferences values..

def _ init (self, ui):
Constructor

@param ui reference to the user interface object (UI.UserInterface)
QObject. init_ (self, ui)

self. ui = ui

self. initialize()

self. refactoringDefaults = {
"Logging" : 1
}

self. translator = None
self. loadTranslator()

Listing 11: Example for the __init__(self, ui) method

5.4.2 activate(self)

This method is called by the plug-in manager to activate the plug-in object. It must return a
tuple giving a reference to the object implementing the plug-in logic (for on-demand plug-
ins) or None and a flag indicating the activation status. This method should contain all the
logic, that is needed to get the plug-in fully operational (e.g. connect to some signals
provided by ericb). If the plug-in wants to provide an action to be added to a toolbar, this
action should be registered with the toolbar manager instead of being added to a toolbar
directly.
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def activate(self):

Public method to activate this plugin.

@return tuple of None and activation status (boolean)

global refactoringBRMPluginObject

refactoringBRMPluginObject = self

self. object = Refactoring(self, self. ui)

self. object.initActions()

e5App( ) .registerPluginObject ("RefactoringBRM", self. object)

self. mainMenu = self._ object.initMenu()
extrasAct = self. ui.getMenuBarAction("extras")
self. mainAct = self. ui.menuBar()\
.insertMenu(extrasAct, self. mainMenu)
self. mainAct.setEnabled(\
e5App () .getObject ("ViewManager") .getOpenEditorsCount())

self. editorMenu = self. initEditorMenu()
self. editorAct = self. editorMenu.menuAction()

self.connect(e5App().getObject("ViewManager"),
SIGNAL( 'lastEditorClosed'),
self. lastEditorClosed)
self.connect(e5App().getObject("ViewManager"),
SIGNAL("editorOpenedEd"),
self. editorOpened)
self.connect(e5App().getObject("ViewManager"),
SIGNAL("editorClosedEd"),
self. editorClosed)

self.connect(self. ui, SIGNAL('preferencesChanged'),
self. object.preferencesChanged)

self.connect(e5App().getObject("Project"), SIGNAL('projectOpened'),
self. object.projectOpened)

self.connect(e5App().getObject("Project"), SIGNAL('projectClosed'),
self. object.projectClosed)

self.connect(e5App().getObject("Project"), SIGNAL('newProject'),
self. object.projectOpened)

for editor in e5App().getObject("ViewManager").getOpenEditors():
self. editorOpened(editor)

return None, True

Listing 12: Example for the activate(self) method

5.4.3 deactivate(self)

This method is called by the plug-in manager to deactivate the plug-in object. It is called
for modules, that have the deactivateable module attribute set to True. This method
should disconnect all connections made in the activate method and remove all menu
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entries added in the activate method or somewhere else. If the cleanup operations are not
done carefully, it might lead to crashes at runtime, e.g. when the user invokes an action,
that is no longer available. If the plug-in registered an action with the toolbar manager, this
action must be unregistered.

def deactivate(self):

Public method to deactivate this plugin.

e5App () .unregisterPluginObject ("RefactoringBRM")

self.disconnect(e5App().getObject("ViewManager"),
SIGNAL( 'lastEditorClosed'),
self. lastEditorClosed)
self.disconnect(e5App().getObject("ViewManager"),
SIGNAL("editorOpenedEd"),
self. editorOpened)
self.disconnect(e5App().getObject("ViewManager"),
SIGNAL("editorClosedEd"),
self. editorClosed)

self.disconnect(self. ui, SIGNAL('preferencesChanged'),
self. object.preferencesChanged)

self.disconnect(e5App().getObject("Project"), SIGNAL('projectOpened'),
self. object.projectOpened)

self.disconnect(e5App().getObject("Project"), SIGNAL('projectClosed'),
self. object.projectClosed)

self.disconnect(e5App().getObject("Project"), SIGNAL('newProject'),
self. object.projectOpened)

self. ui.menuBar().removeAction(self. mainAct)

for editor in self. editors:
self.disconnect(editor, SIGNAL("showMenu"), self. editorShowMenu)
menu = editor.getMenu("Main")
if menu is not None:
menu.removeAction(self. editorMenu.menuAction())

self. initialize()

Listing 13: Example for the deactivate(self) method

5.4.4 _ loadTranslator(self)

The constructor example shown in Listing 11 loads a plug-in specific translation using this
method. The way, how to do this correctly, is shown in the following listing. It is important
to keep a reference to the loaded QTranslator object. Otherwise, the Python garbage
collector will remove this object, when the method is finished.

Page 27 of 44



The erich plug-in system

def _ loadTranslator(self):
Private method to load the translation file.

loc = self. ui.getLocale()

if loc and loc != "C":
locale dir = os.path.join(os.path.dirname(__file ),
"RefactoringBRM", "il8n")
translation = "brm %s" % loc

translator = QTranslator (None)
loaded = translator.load(translation, locale dir)
if loaded:
self. translator = translator
e5App().installTranslator(self. translator)
else:
print "Warning: translation file '%s' could not be loaded." \
% translation
print "Using default."

Listing 14: Example for the __loadTranslator(self) method

6 Eric5 hooks

This chapter describes the various hooks provided by eric5 objects. These hooks may be
used by plug-ins to provide specific functionality instead of the standard one.

6.1 Hooks of the project browser objects

Most project browser objects (i.e. the different tabs of the project viewer) support hooks.
They provide methods to add and remove hooks.

e addHookMethod(key, method)
This method is used to add a hook method to the individual project browser. “key”
denotes the hook and “method” is the reference to the hook method. The supported
keys and the method signatures are described in the following chapters.

e addHookMethodAndMenuEntry(key, method, menuEntry)
This method is used to add a hook method to the individual project browser. “key”
denotes the hook, “method” is the reference to the hook method and “menuEntry” is
the string to be shown in the context menu. The supported keys and the method
signatures are described in the following chapters.

e removeHookMethod(key)
This method is used to remove a hook previously added. “key” denotes the hook.
Supported keys are described in the followings chapters.

6.1.1 Hooks of the ProjectFormsBrowser object
The ProjectFormsBrowser object supports hooks with these keys.

e compileForm
This hook is called to compile a form. The method must take the filename of the
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form file as it's parameter.

compileAllForms
This hook is called to compile all forms contained in the project. The method must
take a list of filenames as it's parameter.

compileChangedForms
This hook is called to compile all changed forms. The method must take a list of
filenames as it's parameter.

compileSelectedForms
This hook is called to compile all forms selected in the project forms viewer. The
method must take a list of filenames as it's parameter.

generateDialogCode
This hook is called to generate dialog source code for a dialog. The method must
take the filename of the form file as it's parameter.

newForm
This hook is called to generate a new (empty) form. The method must take the
filename of the form file as it's parameter.

6.1.2 Hooks of the ProjectResourcesBrowser object
The ProjectResourcesBrowser object supports hooks with these keys.

compileResource
This hook is called to compile a resource. The method must take the filename of the
resource file as it's parameter.

compileAllResources
This hook is called to compile all resources contained in the project. The method
must take a list of filenames as it's parameter.

compileChangedResources
This hook is called to compile all changed resources. The method must take a list of
filenames as it's parameter.

compileSelectedResources
This hook is called to compile all resources selected in the project resources viewer.
The method must take a list of flenames as it's parameter.

newResource
This hook is called to generate a new (empty) resource. The method must take the
filename of the resource file as it's parameter.

6.1.3 Hooks of the ProjectTranslationsBrowser object
The ProjectTranslationsBrowser object supports hooks with these keys.

e extractMessages

This hook is called to extract all translatable strings out of the application files. The
method must not have any parameters. This hook should be used, if the translation
system is working with a translation template file (e.g. *.pot) from which the real
translation files are generated with the generate. .. methods below.
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6.2

generateAll
This hook is called to generate translation files for all languages of the project. The
method must take a list of filenames as it's parameter.

generateAllwithObsolete

This hook is called to generate translation files for all languages of the project
keeping obsolete strings. The method must take a list of flenames as it's
parameter.

generateSelected
This hook is called to generate translation files for languages selected in the project
translations viewer. The method must take a list of filenames as it's parameter.

generateSelectedwithObsolete

This hook is called to generate translation files for languages selected in the project
translations viewer keeping obsolete strings . The method must take a list of
filenames as it's parameter.

releaseAll
This hook is called to release (compile to binary) all languages of the project. The
method must take a list of filenames as it's parameter.

releaseSelected

This hook is called to release (compile to binary) all languages selected in the
project translations viewer. The method must take a list of filenames as it's
parameter.

Hooks of the Editor object

The Editor object provides hooks for autocompletion and calltips. These are the
methods provided to set, unset and get these hooks.

setAutoCompletionHook(self, func)

This method is used to set an autocompletion hook. The function or method passed
in the call must take a reference to the editor and a boolean indicating to complete a
context.

unsetAutoCompletionHook(self)
This method unsets a previously set autocompletion hook.

autoCompletionHook()
This method returns a reference to the method set by a call to
setAutoCompletionHook(self).

setCallTipHook(self, func)

This method is used to set a calltips hook. The function or method passed in the call
must take a reference to the editor, a position into the text and the amount of
commas to the left of the cursor. It should return the possible calltips as a list of
strings.

unsetCallTipHook(self)
This method unsets a previously set calltips hook.

callTipHook(self, )
This method returns a reference to the method set by a call to
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setCallTipHook(self).

7 Erich functions available for plug-in development

This chapter describes some functionality, that is provided by eric5 and may be of some
value for plug-in development. For a complete eric5 API description please see the
documentation, that is delivered as part of eric5.

7.1

The eric5 object registry

Eric5 contains an object registry, that can be used to get references to some of eric5's
building blocks. Objects available through the registry are

DebugServer
This is the interface to the debugger backend.

DebugUI
This is the object, that is responsible for all debugger related user interface
elements.

PluginManager
This is the object responsible for managing all plug-ins.

Project
This is the object responsible for managing the project data and all project related
user interfaces.

ProjectBrowser

This is the object, that manages the various project browsers. It offers (next to
others) the method getProjectBrowser () to get a reference to a specific
project browser (s. the chapter below)

Shell
This is the object, that implements the interactive shell (Python or Ruby).

TaskViewer
This is the object responsible for managing the tasks and the tasks related user
interface.

TemplateViewer
This is the object responsible for managing the template objects and the template
related user interface.

Terminal
This is the object, that implements the simple terminal window.

ToolbarManager

This is the object responsible for managing the toolbars. Toolbars and actions
created by a plug-in should be registered and unregistered with the toolbar
manager.

UserInterface
This is eric5 main window object.

ViewManager
This is the object, that is responsible for managing all editor windows as well as all
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editing related actions, menus and toolbars.

Eric5's object registry is used as shown in this example.

from E5Gui.E5Application import e5App

e5App () .getObject ("Project")

Listing 15: Example for the usage of the object registry

The object registry provides these methods.

7.2

getObject(name)
This method returns a reference to the named object. If no object of the given name
IS registered, it raises a KeyError exception.

registerPluginObject(name, object)

This method may be used to register a plug-in object with the object registry.
“name” must be a unique name for the object and “object” must contain a reference
to the object to be registered. If an object with the given name has been registered
already, a KeyError exception is raised.

unregisterPluginObject(name)
This method may be used to unregister a plug-in object. If the named object has not
been registered, nothing happens.

getPluginObject (name)
This method returns a reference to the named plug-in object. If no object of the
given name is registered, it raises a KeyError exception.

getPluginObjects()
This method returns a list of references to all registered plug-in objects. Each list
element is a tuple giving the name of the plug-in object and the reference.

The action registries

Actions of type E5Action may be registered and unregistered with the Project or the
UserInterface object. In order for this, these objects provide the methods

Project.addE5Actions(actions)
This method registers the given list of ESAction with the Project actions.

Project.removeE5Actions(actions)
This method unregisters the given list of E5SAction from the Project actions.

UserInterface.addE5Actions(actions, type)
This method registers the given list of ESActions with the UserInterface actions
of the given type. The type parameter may be “ui” or “wizards”

UserInterface.removeES5Actions(actions, type)
This method unregisters the given list of ESActions from the UserInterface
actions of the given type. The type parameter may be “ui” or “wizards”
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7.3 The getMenu() methods

In order to add actions to menus, the main eric5 objects Project, Editor and
UserInterface provide the method getMenu(menuName). This method returns a
reference to the requested menu or None, if no such menu is available. menuName is the
name of the menu as a Python string. Valid menu names are:

e Project

Main
This is the project menu

Recent
This is the submenu containing the names of recently opened projects.

VCS
This is the generic version control submenu.

Checks

This is the “Check” submenu
Show

This is the “Show” submenu.
Graphics

This is the “Diagrams” submenu.
Session

This is the “Session” submenu.
Apidoc

This is the “Source Documentation” submenu.
Debugger

This is the “Debugger” submenu.
Packagers

This is the “Packagers” submenu.
Main

This is the editor context menu (i.e. the menu appearing, when the right
mouse button is clicked)

Resources

This is the “Resources” submenu. It is only available, if the file of the editor is
a Qt resources file.

Checks

This is the “Check” submenu. It is not available, if the file of the editor is a Qt
resources file.

Show

This is the “Show” submenu. It is not available, if the file of the editor is a Qt
resources file.

Graphics

This is the “Diagrams” submenu. It is not available, if the file of the editor is a
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Qt resources file.

Autocompletion
This is the “Autocomplete” submenu. It is not available, if the file of the editor
is a Qt resources file.

Exporters

This is the “Exporters” submenu.

Languages

This is the submenu for selecting the programming language.

Eol
This is the submenu for selecting the end-of-line style.

Encodings
This is the submenu for selecting the character encoding.

e Userinterface

file

This is the “File” menu.

edit

This is the “Edit” menu

view

This is the “View” menu.

start

This is the “Start” menu.

debug

This is the “Debug” menu.

unittest

This is the “Unittest” menu.

project

This is the “Project” menu.

extras

This is the “Extras” menu

wizards

This is the “Wizards” submenu of the “Extras” menu.
macros

This is the “Macros” submenu of the “Extras” menu.
tools

This is the “Tools” submenu of the “Extras” menu.
settings

This is the “Settings” menu.

window

This is the “Window” menu.
subwindow
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7.4

This is the “Windows” submenu of the “Window” menu

e toolbars
This is the “Toolbars” submenu of the “Window” menu.

e bookmarks
This is the “Bookmarks” menu.

e plugins
This is the “Plugins” menu.

e help
This is the “Help” menu.

Methods of the PluginManager object

The PluginManager object provides some methods, that might be interesting for plug-in
development.

7.5

isPluginLoaded(pluginName)
This method may be used to check, if the plug-in manager has loaded a plug-in with
the given plug-in name. It returns a boolean flag.

Methods of the UserInterface object

The UserInterface object provides some methods, that might be interesting for plug-in
development.

getMenuAction(menuName, actionName)

This method returns a reference to the requested action of the given menu.
menuName is the name of the menu to search in (see above for valid names) and
actionName is the object name of the action.

getMenuBarAction(menuName)
This method returns a reference to the action of the menu bar associated with the
given menu. menuName is the name of the menu to search for.

registerToolbar(name, text, toolbar)

This method is used to register a toolbar. name is the name of the toolbar as a
Python string, text is the user visible text of the toolbar as a string and toolbar is
a reference to the toolbar to be registered. If a toolbar of the given name was
already registered, a KeyError exception is raised.

unregisterToolbar (name)
This method is used to unregister a toolbar. name is the name of the toolbar as a
Python string.

getToolbar (name)

This method is used to get a reference to a registered toolbar. If no toolbar with the
given name has been registered, None is returned instead. name is the name of the
toolbar as a Python string.

addSidewidget(side, widget, icon, label)
This method is used to add a widget to one of the valid sides. Valid values for the
side parameter are UserInterface.LeftSide and
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UserInterface.BottomSide.

e removeSideWidget(widget)
This method is used to remove a widget that was added using the previously
described method. All valid sides will be searched for the widget.

e getlLocale()
This method is used to retrieve the application locale as a Python string.

e versionIsNewer(required, snapshot = None)
This method is used to check, if the eric5 version is newer than the one given in the
call. If a specific snapshot version should be checked, this should be given as well.
“snapshot” should be a string of the form “yyyymmdd”, e.g. “20080719". If no
shapshot is passed and a snapshot version of eric5 is discovered, this method will
return True assuming, that the snapshot is new enough. The method returns True, if
the eric5 version is newer than the given values.

7.6 Methods of the E5ToolBarManager object

The E5ToolBarManager object provides methods to add and remove actions and
toolbars. These actions and toolbars are used to build up the toolbars shown to the user.
The user may configure the toolbars using a dialog. The list of available actions are those,
managed by the toolbar manager.

e addAction(action, category)
This method is used to add an action to the list of actions managed by the toolbar
manager. action is a reference to a QAction (or derived class); category is a
string used to categorize the actions.

e removeAction(action)
This method is used to remove an action from the list of actions managed by the
toolbar manager. action is a reference to a QAction (or derived class).

e addToolBar(toolBar, category)
This method is used to add a toolbar to the list of toolbars managed by the toolbar
manager. toolBar is a reference to a QToolBar (or derived class); category is a

string used to categorize the actions of the toolbar.

e removeToolBar(toolBar)
This method is used to remove a toolbar from the list of toolbars managed by the
toolbar manager. toolBar is a reference to a QToolBar (or derived class).

7.7 Methods of the Project object

The Project object provides methods to store and retrieve data to and from the project
data store. This data store is saved in the project file.

e (getData(category, key)
This method is used to get data out of the project data store. category is the
category of the data to get and must be one of

e CHECKERSPARMS
Used by checker plug-ins.

e PACKAGERSPARMS
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Used by packager plug-ins.

e DOCUMENTATIONPARMS
Used by documentation plug-ins.

e OTHERTOOLSPARMS
Used by plug-ins not fitting the other categories.

The key parameter gives the key of the data entry to get and is determined by the
plug-in. A copy of the requested data is returned.

setData(category, key, data)
This method is used to store data in the project data store. category is the
category of the data to store and must be one of

e CHECKERSPARMS
Used by checker plug-ins.

e PACKAGERSPARMS
Used by packager plug-ins.

e DOCUMENTATIONPARMS
Used by documentation plug-ins.

e OTHERTOOLSPARMS
Used by plug-ins not fitting the other categories.

The key parameter gives the key of the data entry to get and is determined by the
plug-in. data is the data to store. The data is copied to the data store by using the
Python function copy.deepcopy().

In addition to this the Project object contains methods to register and unregister
additional project types.

registerProjectType(type_, description, fileTypeCallback =
None, binaryTranslationsCallback = None,
lexerAssociationCallback = None)

This method registers a new project type provided by the plugin. The parameters to
be passed are

o type_
This is the new project type as a Python string.

e description
This is the string shown by the user interface. It should be a translatable
string of the project type as a string.

e fileTypeCallback
This is a reference to a function or method returning a dictionary associating
a filename pattern with a file type (e.g. *.html -> FORMS). The file type must
be one of

e FORMS

e INTERFACES
e RESOURCES
e SOURCES
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e TRANSLATIONS

e binaryTranslationsCallback
This is a reference to a function or method returning the name of the binary
translation file given the name of the raw translation file.

e lexerAssociationCallback
This is a reference to a function or method returning the lexer name to be
used for syntax highlighting given the name of a file (e.g. *.html -> Django)

e unregisterProjectType(self, type_)
This method unregisters a project type previously registered with the a.m. method.
type_ must be a known project type.

7.8 Methods of the ProjectBrowser object

The ProjectBrowser object provides some methods, that might be interesting for plug-
in development.

e getProjectBrowser(name)
This method is used to get a reference to the named project browser. name is the
name of the project browser as a Python string. Valid names are

e sources
e forms

e resources

e translations
e interfaces

e others

e getProjectBrowsers()
This method is used to get references to all project browsers. They are returned as
a Python list in the order

e project sources browser

e project forms browser

e project resources browser
e project translations browser
e project interfaces browser
e project others browser

7.9 Methods of QScintilla.Lexer

The QScintilla.Lexer package provides methods to register and unregister lexers
(syntax highlighters) provided by a plugin.
e registerLexer(name, displayString, filenameSample,

getLexerFunc, openFilters = [],
saveFilters = [], defaultAssocs = [])
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This method is used to register a new custom lexer. The parameters are as follows.

name

This parameter is the name of the new lexer as a Python string.
displayString

This parameter is the string to be shown in the user interface as a string.

filenameSample

This parameter should give an example filename used to determine the
default lexer of a file based on it's name (e.g. dummy.django). This
parameter should be given as a Python string.

getLexerFunc

This is a reference to a function instantiating the specific lexer. This function
must take a reference to the parent as it's only argument and return the
reference to the instantiated lexer object.

openFilters
This is a list of open file filters to be used in the user interface as a 1ist of
strings..

saveFilters
This is a list of save file filters to be used in the user interface as a 1ist of
strings.

defaultAssocs
This gives the default lexer associations as a list of strings of flename
wildcard patterns to be associated with the lexer

unregisterLexer(name)
This method is used to unregister a lexer previously registered with the a.m.
method. name must be a registered lexer.

7.10 Signals

This chapter lists some Python type signals emitted by various eric5 objects, that may be
interesting for plug-in development.

showMenu
This signal is emitted with the menu name as a Python string and a reference to the
menu object, when a menu is about to be shown. It is emitted by these objects.

Project
It is emitted for the menus

e Main
the Project menu

e VCS
the Version Control submenu

e Checks
the Checks submenu

e Packagers
the Packagers submenu
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ApiDoc

the Source Documentation submenu
Show

the Show submenu

Graphics

the Diagrams submenu

ProjectSourcesBrowser
It is emitted for the menus

Main

the context menu for single selected files
MainMulti

the context menu for multiple selected files
MainDir

the context menu for single selected directories

MainDirMulti
the context menu for multiple selected directories

MainBack
the background context menu

Show
the Show context submenu

Checks
the Checks context submenu

Graphics
the Diagrams context submenu

ProjectFormsBrowser
It is emitted for the menus

Main

the context menu for single selected files
MainMulti

the context menu for multiple selected files
MainDir

the context menu for single selected directories

MainDirMulti
the context menu for multiple selected directories

MainBack
the background context menu

ProjectResourcesBrowser
It is emitted for the menus

Main
the context menu for single selected files
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MainMulti

the context menu for multiple selected files
MainDir

the context menu for single selected directories

MainDirMulti
the context menu for multiple selected directories

MainBack
the background context menu

ProjectTranslationsBrowser
It is emitted for the menus

Main

the context menu for single selected files
MainMulti

the context menu for multiple selected files
MainDir

the context menu for single selected directories

MainBack
the background context menu

ProjectInterfacesBrowser
It is emitted for the menus

Main

the context menu for single selected files
MainMulti

the context menu for multiple selected files
MainDir

the context menu for single selected directories

MainDirMulti
the context menu for multiple selected directories

MainBack
the background context menu

ProjectOthersBrowser
It is emitted for the menus

Main
the context menu for single selected files

MainMulti
the context menu for multiple selected files

MainBack
the background context menu

Editor
It is emitted for the menus
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Main

the context menu

Languages

the Languages context submenu

Encodings
the Encodings context submenu

Eol
the End-of-Line Type context submenu

Autocompletion
the Autocomplete context submenu

Show

the Show context submenu
Graphics

the Diagrams context submenu
Margin

the margin context menu

Checks
the Checks context submenu

Resources
the Resources context submenu

e UserInterface
It is emitted for the menus

File
the File menu

Extras
the Extras menu

Wizards
the Wizards submenu of the Extras menu

Tools
the Tools submenu of the Extras menu

Help
the Help menu

Windows
the Windows menu

Subwindows
the Windows submenu of the Windows menu

e editorOpenedEd
This signal is emitted by the ViewManager object with the reference to the editor
object, when a new editor is opened.

e editorClosedEd
This signal is emitted by the ViewManager object with the reference to the editor
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object, when an editor is closed.

lastEditorClosed
This signal is emitted by the ViewManager object, when the last editor is closed.

projectOpenedHooks()
This signal is emitted by the Project object after a project file was read but before
the projectOpened() signal is sent.

projectClosedHooks()
This signal is emitted by the Project object after a project file was clsoed but
before the projectClosed() signal is sent.

newProjectHooks()
This signal is emitted by the Project object after a new project was generated but
before the newProject() signal is sent.

projectOpened
This signal is emitted by the Project object, when a project is opened.

projectClosed
This signal is emitted by the Project object, when a project is closed.

newProject
This signal is emitted by the Project object, when a new project has been
created.

preferencesChanged
This signal is emitted by the UserInterface object, when some preferences have
been changed.

EditorAboutToBeSaved
This signal is emitted by the each Editor object, when the editor contents is about
to be saved. The filename is passed as a parameter.

EditorSaved
This signal is emitted by the each Editor object, when the editor contents has
been saved. The filename is passed as a parameter.

EditorRenamed
This signal is emitted by the each Editor object, when the editor has received a
new filename.

8 Special plug-in types

This chapter describes some plug-ins, that have special requirements.

8.1 VCS plug-ins

VCS plug-ins are loaded on-demand depending on the selected VCS system for the
current project. VCS plug-ins must define their type by defining the module attribute
pluginType like

pluginType = "version_control"
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VCS plug-ins must implement the getVcsSystemIndicator () module function. This
function must return a dictionary with the indicator as the key as a Python string and a
tuple of the VCS name (Python string) and the VCS display string (string) as the value. An
example is shown below.

def getVcsSystemIndicator():

Public function to get the indicators for this version control system.

@return dictionary with indicator as key and a tuple with the vcs name
(string) and vcs display string (string)

global displayString, pluginTypename

data = {}

data[".svn"] = (pluginTypename, displayString)

data["_svn"] = (pluginTypename, displayString)

return data

Listing 16: Example of the getVcsSystemindicator() function

8.2 ViewManager plug-ins

ViewManager plug-ins are loaded on-demand depending on the selected view manager.
The view manager type to be used may be configured by the user through the
configuration dialog. ViewManager plug-ins must define their type by defining the module
attribute pluginType like

pluginType = "viewmanager"

The plug-in module must implement the previewPix () method as described above.
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